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About This Document

This document provides quick start steps that explain how to start the BEA Liquid Data
for WebLogic™ server, bring up the WebLogic Server Administration Console and
use it to configure some data sources, use the Data View Builder to map source and
target schemas and construct a query, and run the query against the server.

This document covers the following topics:

m  “Step 1. Start the Samples Server” on page 1-2

m  “Step 2. Start the WLS Administration Console” on page 1-3
m  “Step 3. Configure Order Query Data Sources” on page 1-4

m  “Step 4. Start the Data View Builder and Verify the Data Sources You
Configured Show Up in Builder Toolbar” on page 1-13

m “Step 5. Construct the Query” on page 1-14

m  “Step 6. View and Test the Query” on page 1-24

What You Need to Know

This document is intended mainly for business users/developers and XML data
designers who will be using Liquid Data to design distributed data solutions and
construct queries. System Administrators will also find the initial steps useful as a
snapshot example of the configuration process.
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e-docs Web Site

BEA product documentation is available on the BEA corporate Web site. From the
BEA Home page, click on Product Documentation or go directly to the “e-docs”
Product Documentation page at http://e-docs.bea.com.

How to Print the Document

You can print a copy of this document from a Web browser, one file at a time, by using
the File—>Print option on your Web browser.

A PDF version of this document is available on the Liquid Data documentation Home
page on the e-docs Web site (and also on the documentation CD). You can open the
PDF in Adobe Acrobat Reader and print the entire document (or a portion of it) in book
format. To access the PDFs, open the Liquid Data documentation Home page, click the
PDF files button and select the document you want to print.

If you do not have the Adobe Acrobat Reader, you can get it for free from the Adobe
Web site at http://www.adobe.com/.

REI ate d lnfO rm ati On For more information in general about

Java and XQuery, refer to the following sources.

m  The Sun Microsystems, Inc. Java site at:

http://java. sun. con!

m  The World Wide Web Consortium XML Query section at:
http://ww. w3. or g/ XM/ Query

For more information about BEA products, refer to the BEA documentation site at:

http://edocs. bea. cont
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Contact Us!

Your feedback on the BEA Liquid Data documentation is important to us. Send us
e-mail at docsupport@bea.com if you have questions or comments. Your comments
will be reviewed directly by the BEA professionals who create and update the Liquid
Data documentation.

In your e-mail message, please indicate that you are using the documentation for the
BEA Liquid Data for WebLogic 1.0 release.

If you have any questions about this version of Liquid Data, or if you have problems
installing and running Liquid Data, contact BEA Customer Support through BEA
WebSupport at www.bea.com. You can also contact Customer Support by using the
contact information provided on the Customer Support Card, which is included in the
product package.

When contacting Customer Support, be prepared to provide the following information:
®  Your name, e-mail address, phone number, and fax number

®  Your company name and company address

m  Your machine type and authorization codes

m  The name and version of the product you are using

m A description of the problem and the content of pertinent error messages

Documentation Conventions

The following documentation conventions are used throughout this document.

Convention Item

boldface text  Indicates terms defined in the glossary.

Ctrl+Tab Indicates that you must press two or more keys simultaneously.
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Convention

Item

italics Indicates emphasis or book titles.
nonospace Indicates code samples, commands and their options, data structures and
t ext their members, data types, directories, and file names and their extensions.
Monospace text also indicates text that you must enter from the keyboard.
Examples:
#include <iostreamh> void main ( ) the pointer psz
chnod u+w *
\'t ux\ dat a\ ap
. doc
t ux. doc
Bl TVAP
fl oat
nonospace Identifies significant words in code.
bol df ace Example:
t ext . .
void commt ()
nonospace Identifies variables in code.
italic Example:
t ext .
String expr
UPPERCASE Indicates device names, environment variables, and logical operators.
TEXT Examples:
LPT1
SIGNON
OR
{1} Indicates a set of choices in a syntax line. The braces themselves should

never be typed.

Indicates optional items in a syntax line. The brackets themselves should
never be typed.

Example:

buildobjclient [-v] [-0 name ] [-f file-list]...
[-1 file-list]...
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Convention

Item

Separates mutually exclusive choices in a syntax line. The symbol itself
should never be typed.

Indicates one of the following in a command line:

m  That an argument can be repeated several times in a command line

m  That the statement omits additional optional arguments

m  That you can enter additional parameters, values, or other information
The ellipsis itself should never be typed.

Example:

buil dobjclient [-v] [-0 name ] [-f file-list]...
[-1 file-list]...

Indicates the omission of items from a code example or from a syntax line.

The vertical ellipsis itself should never be typed.

Getting Started
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CHAPTER

1

Getting Started with

Liquid Data: A Basic
Example

These Getting Started steps walk you through a simple example to illustrate the general
process of configuring some data sources and constructing a query. This example
shows how to build a query similar to the Order Query used in our BEA Liquid Data
for WebLogic™ “Avitek Sample.” Following through this process using our example
query is an easy and fun way to get familiar with how to configure data sources,
construct data views, and run the generated queries in Liquid Data.

Please note that this topic is meant to serve as an example only to familiarize you with
the most common tasks of configuration and query building—it is not comprehensive
or required. For more advanced query examples, see the Query Cookbook in Building
Queries and Data Views and the Samples readme files and project files that are
installed with Liquid Data. For details on how to set up and manage Liquid Data and
configure data sources, see the Liquid Data Administration Guide. For information on
building queries and using the Data View Builder, see Building Queries and Data
Views.

The following sections are included here:

m  Step 1. Start the Samples Server

m  Step 2. Start the WLS Administration Console
m  Step 3. Configure Order Query Data Sources

m  Step 4. Start the Data View Builder and Verify the Data Sources You Configured
Show Up in Builder Toolbar
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1 Getting Started with Liquid Data: A Basic Example

m Step 5. Construct the Query (View a Demo)
m  Step 6. View and Test the Query
m  Step 7. Save the Project

m  Next Steps

Step 1. Start the Samples Server

If you have not already done so, start the Liquid Data Samples server.

If you have just installed Liquid Data and this the first time running the Samples server
after installation, be sure to first populate the Samples database by choosing the
following menu option:

Start—>Programs—>BEA WebLogic Platform 7.0—>Liquid Data for WebLogic
1.0—>Liquid Data Samples—>First-Time Samples Configuration

Wait for the Samples setup to complete. Now you are ready to start the server.

m  To start the Samples server on Windows, choose the following menu option:

Start—>Programs—>BEA WebLogic Platform 7.0—>Liquid Data for
WebLogic 1.0—>Liquid Data Samples—>Launch Samples Server

m  To start the Samples server on UNIX, run the st art WebLogi ¢. sh command in
the following domain:

BEA Honme/ W._HOVE/ | i qui ddat a/ sanpl es/ confi g/ | d_sanpl es/ st art Wbl ogi c. sh

Note: For more information on setting up and starting the Samples server, see
Post-Installation Tasks in Installing Liquid Data. For more information on
starting Liquid Data servers in the various preconfigured domains, see Starting
and Stopping the Server in the Liquid Data Administration Guide.
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Step 2. Start the WLS Administration Console

Step 2. Start the WLS Administration
Console

To start the WLS Administration Console for the Liquid Data Samples server running
on your local machine, type the following URL in a Web browser address field:

http://1ocal host: 7001/ consol e/
Login to the console by providing the following default username and password for the

Samples server.

Table 1-1 User Name and Password for Samples WLS Administration Console

Field Defaults
Username system
Password security

The Console Home Page is displayed.
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1 Getting Started with Liquid Data: A Basic Example

Figure 1-1 Samples WLS Administration Console

) WebLogic Server Consale - Microsoft Internet Explorer _ ol x|

JFiIe Edit ¥iew Favorites Tools Help

| Address |@ hitp:fflocalhost:700 1 feonsoleactions mbean(MBeanFramesetAction?sideharFrameld=wl_ronsole_frame_10273718180598ist | @ G0

Heervers I .
Hlciusters Welcome to BEA WebLogic Server Home
Eutachines - p— P -
ElMetwork Channel Connected to localhost: 7001 A Diotnain: Id

= DDe;:uloyfmems
leppliCaI\UﬂS

Information and Resources

Eless Helpful Tools General Information
Elven applicat Convert weblogic properies Read the documentation
Elweb Senice ¢ Configure applications Set yiour console preferences

mCDI’]I’]ECTUI’S
Elstartup & shu Domain Configurations

B Hzervices PO
" . Your Application's
gjgggl Network conflguratlon Your Deploved Resources Security Settings
= Domains Applications Realms
Eluessaging Bt Servers EJE
Elaa Clusters Web Applications
S Machines Web Service Companents
s Metwiork Channels Connectors
Elwiec |
EdwebLogic Tu Startup & Shutdowm
s N EETT—— i
Evirual Hosls ervices Configurations
Elwail JDBC SNMP Other Services
- ElFileTs Connection Pools Agent HMWL Registries
@S““m_ ) MuliPools Proxies JTA Configuration
Compatihility Sec
Domain Log Filte Data Sources Momtgrs Virtual Hosts .
ElTasks Tx Data Sources Log Filters Domain-wide Logging _
@ Linuid Data EliE e | _,l—l
‘@ ’_,_ (3 Local intranst 4

Note: For more information on using the Administration Console, see starting the
Using the WLS Administration Console in the Liquid Data Administration
Guide.

Step 3. Configure Order Query Data Sources

This section describes how to configure the two data sources used in the Order Query
in the Sample:

®  An Relational Database Liquid Data data source description for customer and
order based on a Wireless customer database
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Step 3. Configure Order Query Data Sources

m  An XML Liquid Data data source description for customer and order

information based on a BroadBand customer database

Configure a Relational Database Data Source
Description for the Wireless Data

Configuring a Relational Database Liquid Data source description consists of first
creating a JDBC connection pool and JDBC data source, and then configuring the
Liquid Data data source using the JDBC configuration you just created. Each of these
tasks is described here:

m  Create and Deploy the JDBC Connection Pool

m  Create and Deploy the JDBC Data Source

m  Configure the Relational Database Data Source Description

Note: For detailed information on configuring Relational Database data sources in

Liquid Data, see Configuring Access to Relational Databases in the Liquid
Data Administration Guide.

Create and Deploy the JDBC Connection Pool

1.
2.

In the left pane, expand the Services node.
Expand the JDBC node.

Click on Connection Pools.

A table of existing connection pools, if any, is shown.

Click the “Configure a new JDBC connection pool” text link to display the JDBC
pool General configuration tab.
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1 Getting Started with Liquid Data: A Basic Example

Figure 1-2 JDBC Connection Pool General Configuration Tab

Id samples> JDBC Connection ...> MyWirelessPool

s [BEUE  Targets | Monitoring | Motes

General || Connections || Testing

&2 Name: MyitirelessPool
&% URL: Jidbc:paintbase:ocalhost9naziL
A7 Driver Classhame: |eorm.pointbase jdbcjdbclniverse
user=wireless ;I
&@ Properties password=wireless
(key=value).
E
&7 ACLName: [
&2 Password: Change...
A7 Open String Password: Change...

Apply |

5. On the General tab, provide information about the JDBC connection pool you
want to create as described in the following table.

Table 1-2 JDBC Connection Pool Configuration for PB-WL Data Source

Field Value to Enter

Name MW r el essPool

This is the name of the JDBC Connection Pool. You can choose any meaningful name.

URL j dbc: poi nt base: / /1 ocal host: 9092/ LDDB

This is the URL for the database. In this case, we are using the PointBase database
installed with the Samples.

Driver Classname com poi nt base. j dbc. j dbcUni versal Dri ver

This is the driver classname for the database. In this case, we are using the driver for the
PointBase database installed with the Samples.
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Step 3. Configure Order Query Data Sources

Table 1-2 JDBC Connection Pool Configuration for PB-WL Data Source

Field

Value to Enter

Properties

user=wirel ess
passwor d=wi r el ess

User name and password based on security set up on the database. Those provided here
are the default username and password for the Samples database. You can add these as
comma separated attribute=value pairs or one per line as shown above.

10.

11.

12.

Click Create.

The new JDBC connection pool you created is shown in the table.

In the table of connection pools, click on the name of the new JDBC connection
pool you just created.

The Configuration and Monitoring tabs for that pool are displayed.
Click on the Configuration tab.

Click on the Connections tab and set the Maximum Capacity to 10. (This is an
optional step, but we suggest setting the Maximum Capacity on the JDBC
connection pool to some number greater than 1.)

Click on the Targets tab.
The name of your Liquid Data server should be listed under Available Servers.

Select the Liquid Data server in Available and click the right arrow button to
move the server into the Chosen list.

Click Apply.

Create and Deploy the JDBC Data Source

1.
2.
3.

In the left pane, expand the Services node.
Expand the JDBC node.

Click on Data Sources.

A table of existing data sources, if any, is shown.
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1 Getting Started with Liquid Data: A Basic Example

4. Click the “Configure a new JDBC Data Source connection pool” text link to
display the JDBC data source General configuration tab.

Figure 1-3 JDBC Data Source General Configuration Tab

ld samples> JDBC Data Sources> Create a new

Configuration JEER R ==

AP Name: [MywirslessDs
&% JNDI Name: [pyvirelessDs
&9 Pool Name IMyWire\essPDDH

AT I Row Prefetch Enabled

A7 Row Prefetch Size: [

A% Stream Chunk Size: [256 bytes

5. On the General tab, provide information about the JDBC data source you want to
create as described in the following table.

Table 1-3 JDBC Data Source Configuration for PB-WL Data Source

Field Value to Enter and Explanation

Name MW r el essDS

This is a logical name we’ll use for the JDBC data source.

JNDI Name MW r el essDS

In this example we make the JDBC Data Source Name and JDBC JNDI Name the same.
The JNDI name will be used in the Liquid Data data source configuration (as described
in “Configure the Relational Database Data Source Description”).

Pool Name MW r el essPool

The Pool Name must match the name of the Connection Pool created in “Create and
Deploy the JDBC Connection Pool” on page 1-5.

6. Click Create.

The new JDBC data source you created is shown in the table.
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Step 3. Configure Order Query Data Sources

10.

11.

In the table of JDBC data sources, click on the name of the new JDBC data
source you just created.

The Configuration and Monitoring tabs for that JDBC data source are displayed.
Click on the Configuration tab.

Click on the Targets tab.

The name of your Liquid Data server should be listed under Available Servers.

Select the Liquid Data server in Available and click the right arrow button to
move the server into the Chosen list.

Click Apply.

Configure the Relational Database Data Source Description

Now you are ready to add a description of your Relational Database data source to the
Liquid Data Server registry. To do this:

1.
2.
3.

In the left pane, click the Liquid Data node.
In the right pane, click the Configuration tab.
Click the Data Sources tab.

Click the Relational Databases tab.

Click the “Configure a new Relational Database source description” text link to
display Configure tab.
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1 Getting Started with Liquid Data: A Basic Example

Figure 1-4 Liquid Data Relational Databases Configuration Tab on the Liquid
Data Node

Id_samples> Liquid Data> Configuration> Data
Sources> Relational Databases> Configure a Relational =
Database Data Source Descriptio =

Connected to localhost: 7001 AC

hon Jul 22 14:14:03 PDT 2002

Dornain: |d_samples

?Name: * [mywieless-LDDS

?Data Source Name: * [MypirelessDs

ZUser Name: 1

ZPassword:; 1

?Schema [wrECESS

7 Catalog 1

ZTable Pattern 1

P Timeout 1

7 Shared Connection: m]

Zlsolation Level: | =l
7 Maximum Connections: I—

Create |

6. Fill in the fields for your data source as described in the following table. (You
need only fill in the fields detailed in the following table—leave other fields
blank.)

Table 1-4 Liquid Data Source Description for PB-WL Data Source

Field Value to Enter

Name M/W el ess- LD DS
This is the logical name of the database—it is a Liquid Data source description used to
register the Relational Database data source with the Liquid Data server. You can choose
any meaningful name. For this example, use the name we suggest here.
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Step 3. Configure Order Query Data Sources

Table 1-4 Liquid Data Source Description for PB-WL Data Source

Field Value to Enter

Data Source Name M/W r el essDS

This is the database name; it must match the JNDI name for the JDBC data source
created in “Create and Deploy the JDBC Data Source” on page 1-7.

Schema W RELESS
The schema name given here must match the name of a schema stored in your database.

In this case, we are using the WIRELESS schema provided in the Samples database.

Note: The way in which you define schema varies depending on the type of
database you are using. For more detailed information, see Configuring
Access to Relational Databases in the Liquid Data Administration
Guide.

7. Click Create.

You can click on Relational Databases in the breadcrumbs path at the top of the
console to see the relational database you added displayed in the summary table.

Configure an XML File Data Source Description for the
BroadBand Data

Configuring an XML File data source description in Liquid Data simply consists of
configuring it as a resource using the Liquid Data node in the WLS Administration
Console:

1. In the left pane, click the Liquid Data node.
2. In the right pane, click the Configuration tab.
3. Click the Data Sources tab.

4. Click the XML Files tab.

5. Click the “Configure a new XML data source description” text link to display
Configure tab.
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1 Getting Started with Liquid Data: A Basic Example

Co cte oca
Configure

Figure 1-5 XML Configuration Tab on the Liquid Data Node

ld samples> Liquid Data> Configuration> Data
Sources> XML Files> Configure a XML File Data Source

Active Domain: |d samples Wan J 21:09 POT 2002

PName: * [MyBroadBand-L0-DS

2 Data File: * |b-coxml Browse Repository
2 Schema File: brcoxsd Browise Repository

Create |

6. Fill in the fields for your data source as described in the following table.

Table 1-5 Liquid Data Data Source Description for My-PB-WL Data Source

Field

Value to Enter

Name

MyBr oadBand- LD- DS

This is the name of the Liquid Data data source description used to register the XML data
source with the Liquid Data server. You can choose any meaningful name.

Data File

b-co. xm

This is the XML data file name. It must correspond to an XML data file stored in the
Liquid Data server repository. (The example file name provided above does reside in the
Samples server repository.)

Schema

b- co. xsd

Schema for the XML file. The schema you specify here must be in the Liquid Data server
Repository. The schema used for this example is provided in the Repository along with
the samples.

7. Click Create.

You can click on XML Files in the breadcrumbs path at the top of the console to see
the file you added displayed in the summary table.

Note: For detailed information on configuring XML data sources in Liquid Data, see

Configuring Access to XML Files in the Liquid Data Administration Guide.
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Step 4. Start the Data View Builder and Verify the Data Sources You Configured Show

Step 4. Start the Data View Builder and
Verify the Data Sources You Configured
Show Up in Builder Toolbar

To start the Data View Builder and connect to the Samples server, do the following:

1. Start the Data View Builder.

e On a Windows platform, choose the menu item:
Start—>Programs—>BEA WebLogic Platform 7.0—>Liquid Data for
WebLogic 1.0—>Launch Data View Builder

You can also start the Data View Builder by double-clicking on the file:
BEA Hone\ W._HOME\ | i qui ddat a\ Dat aVi ewBui | der\ bi n\ DVBui | der. cnd

e On a UNIX platform, open a command window and change directories into
the following directory:

BEA Hone/ W._HOVE/ | i qui ddat a/ Dat aVi ewBui | der/ bi n
Enter the following command at the prompt to start the Data View Builder:
sh DVBui | der. sh

2. Connect to the Samples server.

a. Enter the following address in the Server URI field on the Login window. (No
username or password is required here. Leave those fields blank.)

t3://1ocal host: 7001

b. Click the Login button.

The Data View Builder workspace and tools are displayed. You can click on the
buttons on the left Navigation panel to view the various types of data sources
configured on the Liquid Data server to which your Data View Builder is
connected. In this case, we are connected to the Samples server.
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1 Getting Started with Liquid Data: A Basic Example

Figure 1-6 Starting the Data View Builder

ﬂ[untitled]"’ - Data Yiew Builder

=10l x|

File Edit Wiew Query Window Help

[ Diata Wiews ] new_element- Target
| RIL DS | nesy_element - xsistring
= xml
i[5 MyBroadBand-LD-DS
/| ¥h-BE-C

Source I Target |

[=
Relational Datahases 1 I=]

Weh Services W & Mappingfor [Al ~] Showy full path
Application Views

Sources ‘Tnnlhnx| Mappings |CundniunsH Sort Elyl

Connected to t3:lacalhost 7001

3. The data sources you just configured on the Samples server should be available
in the Data View Builder. To find them, click the buttons on the left for the
appropriate data source types:

e Click Relational Databases to view the configured relational databases. This

list should include your new Relational Database data source:
M/W r el ess- LD- DS

e Click XML Files to view the configured XML data sources. This list should
include your new XML data source: MyBr oadBand- LD- DS

Step 5. Construct the Query

The Data View Builder allows you to construct queries (or data views) by dragging and

dropping elements or nodes in source and target schemas for the data sources with
which you are working.
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Step 5. Construct the Query

You can drag and drop elements among source schemas and use other tools (such as
constants and functions) to express the query statement. This is also referred to as
defining source conditions.

You can also drag and drop elements from your source schemas to the target schema
to shape and define the structure of the query result. This is also referred to as mapping.

As you work in Design mode with the data elements and attributes in source and target
schemas using drag-and-drop actions to join or map elements, Data View Builder is
generating the XQuery for the query in the background. You can also use the Data
View Builder to run the query and view the results in Test Query mode—as a way of
testing queries as you build them.

The query you are about to build here is similar to the Order Query featured in the
Liquid Data Avitek Sample. Given a customer with orders stored in two data sources
(“Wireless™ orders in a relational database and “Broadband” orders in an XML file),
this query will return the order information for that customer.

To construct our sample Order Query, you need to do the following:
m  Open the Data Source Schemas You Need

m  Add a Target Schema from the Server Repository

®m  Project the Output by Mapping Source to Target Schema

m  Define the Source Conditions

All of the tasks described in this section are accomplished using the Design tab in the
Data View Builder. For more information on using the tools and features on the Design
tab, see the Design tab in Building Queries and Data Views.

View a Demo

Constructing the “Order Query” Demo... If you are looking at this documentation
online, you can click the “Demo” button to see a viewlet demo showing how to build
the conditions and create the mappings described in this example. This demo previews
the steps described in detail in the following sections.
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Open the Data Source Schemas You Need

To open the data sources you need to construct the data view, simply navigate to them
on the Builder Toolbar—>Sources tab and double-click on them:

1. Click the Design tab.

2. On the Builder Toolbar, click the Sources tab (on the bottom of the left vertical
panel).

3. Open the data source schemas from the Builder toolbar as follows:

e Click Relational Databases and double-click on MyW r el ess- LD- DS data
source to open the associated XML schema.

e Click XML Files and double-click on MyBr oadBand- LD- DS data source to
open the associated XML schema.

The XML schemas for the each of the data sources are displayed.

Note: You can open multiple data source schemas and move them around on the
workspace as needed.

Add a Target Schema from the Server Repository

The target schema we will use for the Order Query is in a file called
cust oner Or der Repor t . xsd which is available in the Samples server repository.

To add the target schema:

1. Choose the menu command File—>Set Target Schema.

This brings up a file browser. Use the file browser to navigate into the server
Repository, which includes several schemas available for use.

2. Choose cust oner Or der Report . xsd and click Open.

cust oner Or der Report . xsd is displayed as the target schema.

Note: You can open only one target schema at a time and it is always docked to the
right side of the workspace.
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At this point, your Data View Builder workspace contains two data source schemas
and a target schemas you plan to work with as shown in the following figure.

Figure 1-7 Data View Builder with Source and Target Schemas

d_data',D¥bldr-projectsmyprojectsiSampleDrderQuery.qpr - Data Yiew Build, = Ellil
File Edit View Query ‘Window Help
Design |Op1imize Test
—
Data Wiews /@ mamretess1n.0s |0 x| My‘BrlJadBand—LD—DS {eustornerOrderReportxsd - Target
KL Files ] = [=] . b CustomerOrderReport
Relational Databases || & W 558 customerOrder-
g = . CUSTOMER* (5~ CUSTOMER _ORDER+ [ CUSTOMER
S rokms [ FIRST_NAME - ¥s:st -] ORDER_DATE - x:string =
be{T) Myiireless-LD-DS i -0 FIRST_MAME - xs:5t
L0 PEER -0 LAST_MAME - xs:sh 4[] ORDER_ID - s string : = T
O CUSTOMER _ID - s te [ CUSTOMER_ID - %z string | - £E
@ PBCR D el -0 CUSTOMER_ID - x=:
- PAIAL ~ STATE - xs:string te [0 SHIP_METHOD - s string Dl STATE - xsiatring
- % B TOTAL_ORDER_SMOUNT| -
é::ﬁoii.gjn:am = N - ! -0 EMAIL_ADDRESS -
STREET_ADDRESZZ E| . WDWELE:SEP;S:Z MLMBE
STREET_ADDRESS1
i -l CUSTOMER_ORDER
CUSTOMER_SINCE -
E| @ broadband_orders
[ L EMAL_ADDRESS - (& CUSTOMER_ORDER,
: -] TELEPHOME_MUMBE—' -
1| e I CUSTOMER_ORDER*
| [l CUSTOMER ORDER LINE
- i O —__ 1]
[ Source I Target
H (R Wyireless-LD-DSJdbfCUSTOMER _ORDE customerOrderReportxsdliCustomerOrderR. . [«
oL MyWireless-LO-DSNdCUSTOMER_ORDE... [customerOrderRepotxsdfCustamerOrderR.
A 2 Wtireless-LD-DSPACUSTOMERITELEPH. [customerOrderReport xsdfCustomerOrderR
1= P P B R T T Y YN T 2T ¥ ot B2 T T PP Py o P Py g 1Tyt Pepeeyepe PO e
[ Wah Services | I || B wanping for: [an [~] Show full path
[ Application Views I
Sources | Toolbox Mappings |ComdmonsH Sort Bv‘
Cannected to t3:Macalhost7001

Project the Output by Mapping Source to Target Schema

Note: To expand the XML element trees in source and target schemas select the top
element, right mouse-click to get the pop-up menu, and choose Expand.

1. The Order Query target schema includes a CUSTOMER ORDER format for both
Wireless and Broadband. So, we’ll start by mapping the CUSTOMER ORDER
elements shown in each data source to the corresponding CUSTOMER ORDER
elements in the target schema as follows:

e Drag and drop the sub-elements contained in the Wireless data source
CUSTOMER_ORDER* into the corresponding sub-elements in the target
schema wireless_orders CUSTOMER ORDER+.
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Figure 1-8 Mapping Wireless CUSTOMER_ORDER to Target Schema

] MyWireless LD-DS - Source | —||C1//% JcustomerOrderReportxsd - Target
A B customerCrder+ [=]

db = - CUSTOMER
Bl cUSTOMER* FIRST_MAME - 2= 2tving ]
o[l FIRST _MAME - x5 =tring LAST_MAKME - xs:string
el LAST_MNAME - xs:string CUSTOMER_ID - ==:string
[l CUSTOMER_ID - %s:string ETATE - x=string
e[l STATE - xs:string EMalL_ADDRESS - ws:string
[l ZIPCODE - %= decimal : TELEPHONE_MUMBER - x=:long
o[l CITY - cazstring (= wireless_orders
[l STREET_ADDRESS2? -xauatring | - =l CUSTOMER_ORDER+
[l STREET_ADDRESST - x=string [0 ORDER_DATE - xs:string
o[l CUSTOMER _SIMCE - x=:date iny[] ORDER_ID - x=:5tring
e[l EMAIL _ADDRESS - xs:string / //D CUSTOMER_ID - xs:string
[l TELEPHOME_MUMBER - xs: dpet // // O SHIP_METHOD - x=:string
=0 CUSTOMER_ORDER® // " / [0 TOTAL_ORDER_AMOUNT - xs:sha
;/ Mcﬂband_ﬁrders

(= CUSTOMER_ORDER+
ORDER_DATE - x=:string
DORDER_ID - w2 atring

-] ORDER_DATEZ S

-] ORDER_ID SSU}/ 5
-] CUSTOMER_ID= x;z);m//
-1 [EHIP_METHOD = sirj §
[ TOTAL_ORDER_AMOUNT - xzic | | CUSTOMER _ID - xs:string

= CUSTOMER _ORDER_LIME _|TER® : SHIP_METHOD - x=:string
- LINE_ID - XS:S’cring_ = “o [l TOTAL_ORDER_AMOUNT - xs:sho=

1 | O AT | D

e Drag and drop the sub-elements contained in the BroadBand data source
CUSTOMER_ORDER* into the corresponding sub-elements in the target

schema wireless orders CUSTOMER ORDER+
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Figure 1-9 Mapping Broadband CUSTOMER_ORDER to Target Schema

[ MyBroadBand-LD-DS - Sou— |01

M db
B l CUSTOMER_ORDER+|

-0 CUSTOMER_|

_ R
e smp_wmokmg\;'\iﬁ
D TOTAL ORDE WS = .\

JcustormnerOrderReportxsd - Target

Customer OrderReport
B custamerOrder+
(-0 CUSTOMER
wireless_orders
=] broadband_orders
JJ-l CUSTOMER_ORDER+
B[] CRDER_DATE - x=:string

# ] ORDER_ID - xs:string

‘L CUSTOMER_ID - x=:string

[ SHIP_METHOD - =s:string

TN TOTAL_ORDER_AMOUNT - xs:shart

4] | IZ|

4] | [v]

In both cases, the sub-elements to map are ORDER DATE, ORDER 1D,
CUSTOMER _ID, SHIP. METHOD and TOTAL ORDER AMOUNT.

Note:

As you drag and drop elements from source to target, the Mappings tab is

automatically displayed in the lower part of the workspace. The mapped
elements are highlighted in the schema windows and each mapping is recorded
on the Mappings tab showing Source and Target details. If you need to delete
a mapping, select it on the Mappings tab by clicking in the Mapping ID field
to highlight the row in which the Source/Target mapping is shown and then

click the Trashcan icon.

2. For this example, we use the Wireless data source schema to format the
CUSTOMER element in the target schema. So we need to map the CUSTOMER
elements shown in the Wireless data source to the CUSTOMER elements in the

target.
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To do this, drag and drop the sub-elements contained in the Wireless data source
CUSTOMER* into the corresponding sub-elements in the target schema

CUSTOMER.

Note: Note that you do not necessarily need to have a target for every source
element. In our example, we create source-to-target mappings for every
node that exists in our target CUSTOMER schema.

Figure 1-10 Mapping Wireless CUSTOMER to Target Schema CUSTOMER

M dh
=0 EUSTOMER?]

-] FIRST_MAME - x=:string

JcustomerOrderReportxsd - Target
] MWiireless-LD-DS - Source | — O/ X |:

CustomerOroerReport

S0 customerCrder+

=0 CUSTOMER

B~ FIRST_MAME - xs:string

I:| LAST_PMAME - x= string
-0 CUSTOMER_ID - x3:string

B[ LAST_NAME - xs:string
P[] CUSTOMER_ID - x=:string

-] STATE - s string
[l ZIPCODE - x5 decimal

-l CITY - x3:atring

-l STREET_ADDRESS27 -xzistri

el CUSTOMER_SING] :
[ EM&IL_ADDRESS~%% string _
e [] TELEPHOME_MUMEER - x3:decimal |
-0 CUSTOMER_ORDER* :
#-E CUSTOMER_ORDER_LIME_ITEM®

- PRODUCTS®

FLl Tl

5; ‘O STATE - x=:string
/v ------ O Emall_ADDRESS - x=:string

1L—~""_W.-[0 TELEPHOME _NUMBER - xs:lang
E/I'__'I -l wirelezs_orders

- hroadband_orders
-0 CUSTOMER_ORDER+
b ] ORDER_DATE - xs:5tring
-] ORDER_ID - x=:=tring
- CUSTOMER_ID - x=:string
- SHIP_METHOD - x=:=string
[ TOTAL_QORDER_AMOUNT - xasl

KT

At this point, you have completed the source to target mappings and the target

schema is ready.

The source-to-target mappings you created are shown on the Mappings tab.
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Figure 1-11 Source-to-Target Mappings

I Source

I Target
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[byBroadBand-LD-DS)idbiCUSTOMER_ORDER..

(custormerOrderReport xsdfCustomerOrderRep...

[tyireless-LD-DSHdiCUSTOMERIFIRST_MA. .

[customerOrderReportxsdiCustomerOrderRep. ..

[biyiireless-LD-DSFdbiCUSTOMERILAST _MAME

[customerOrderReportksdiCustomerQrderRep...

[btyireless-LD-DSIdhiCUSTOMERICUSTOME...

[customerOrderReportxsdiCustomerOrderRep. ..

[biyivireless-LD-DSFdhiCUSTOMERIETATE

[customerOrderReportksdiCustomerQrderRep...

[biyireless-LD-DSHdhiCUSTOMER/EMAIL_AD. ..

[customerOrderReportxsdiCustomerOrderRep. ..

[tyireless-LD-DSIdCUSTOMERTELEFHD...

[customerOrderReportxsdiCustomerOrderRep...

-

Mapping for: |Al

[~]

Show full path

Wappings | Conditions || Sort By|

Define the Source Conditions

The final step in constructing the data view for our example query is to define some

source conditions. This is the way in which you actually pose the “question” (query)
or filter designed to get at the data in a particular way. In this example, we want to find
out which customers (whose customer IDs match a given constant) have orders in both
BroadBand and Wireless.

Create a Join Between the CUSTOMER _IDs in CUSTOMER and
CUSTOMER_ORDER within Wireless

Create a Join between Wireless CUSTOMER _ID and Broadband
CUSTOMER_ID

Use a Function to Retrieve a Customer ID Matching a Given Constant

Getting Started
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Create a Join Between the CUSTOMER_IDs in CUSTOMER and
CUSTOMER_ORDER within Wireless

In the Wireless data source, drag and drop the sub-element CUSTOMER _ID (from
CUSTOMER) to CUSTOMER _ID (subelement in CUSTOMER ORDER) within the
same data source schema window.

This creates a join between CUSTOMER and CUSTOMER _ORDER. The syntax of
this join is displayed on the first row on Conditions tab:

Note: As you drag and drop elements from source element to source element, the
Conditions tab is automatically displayed in the lower part of the workspace.
The mapped elements are highlighted in the schema windows and each source
condition is recorded on the Conditions tab. If you need to delete a condition,
select it on the Conditions tab by clicking in the Condition ID field to highlight
the row in which the condition is shown and then click the Trashcan icon.

Create a Join between Wireless CUSTOMER_ID and Broadband CUSTOMER_ID

Drag and drop the Wireless element CUSTOMER/CUSTOMER _ID onto the
Broadband data source element CUSTOMER/CUSTOMER _ID.

The syntax of this Join is displayed on the next row on the Conditions tab.

Note: If you ran the query at this point, you would get a query result showing all
customers who have orders in both BroadBand and Wireless. In the next step,
however, we refine the query a little further.

Use a Function to Retrieve a Customer ID Matching a Given Constant

You can use a function to create filter that matches a given customer.

1. Ifthe Conditions tab is not already selected in the lower panel, click the Conditions
tab.

2. On the Builder Toolbar (left navigation panel) click the Toolbox tab, then click
Functions.

3. In the Functions panel, expand the Operators list and find the Equals function

(eq).
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4. Drag and drop the eq function from the Builder Toolbar into the first empty row
in under Conditions on the lower part of the workspace.

If you have been following along this will be the third row since it’s the third
source condition you are setting.

This causes the Functions Editor to open automatically. By dragging the eq
function into the conditions you get a “placeholder” equation in the Functions
Editor in the form of:

(anyVal uel - xset:anyVal ue eq anyVal ue2- xset:anyVal ue)

5. Drag the Wireless CUSTOMER 1D (a sub-element of CUSTOMER) into the left
side of the equation (onto the first placeholder, “anyVal uel -
xset : anyVal ue”).

6. On the left navigation panel, click Constants.

7. In the Constants String field, type CUSTOMER 1. Drag and drop the constants
icon (to the right of the field) into the right side of the equation (onto the
remaining placeholder, “anyVal ue2- xset:anyVal ue”).

Figure 1-12 Using a String Constant in a Function

Desigh |0ptimize Test

[ Functions | Enter "CUSTOMER_1" in String Field

| Constants | then drag and drop icon into Conditions row

string = /where you are building the function
usTomMER_1 |7 | //

~Mumbep————————————

| —

~Empty Element

Note: Make sure that you have the left navigation panel expanded out far enough to
the right to be able to see the arrow icons to the left of the Constants fields.

The syntax of this statement is displayed in the Functions Editor.
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Figure 1-13 Equation for a Source Condition Shown in Functions Editor

Click Close
to close the Function Editar

Functions  K[Mwwireless-LD-DENdC USTOMER/CUSTOMER_ID eqg "CUSTOMER_1")
Editor

o Show full path

Mappings | canditions | Sort By|

You can close the Functions Editor by clicking the Close button on it.

You have set up all the source conditions. They are reflected on the Conditions tab.

Note: To see the full text of the source conditions statements, you may have to
expand the Conditions area by clicking and dragging the left or right borders.

Figure 1-14 Source Conditions

Candition far: [All I~

| [ Enabled || Condition

0 (IMyWireless-LO-DSdb/CUSTOMERICUSTOMER_ID eq [MyWireless-LD-DEYdWCUSTO. ]
1 (MyWireless-LD-DE[0b/CUSTOMERICUSTOMER_ID eq [MyBroadBand-LD-DEJd0/CUS...

2 (hhireless-LO-DEidb/CUSTOMERICUSTOMER_ID eq "CUSTOMER_1"

R -

[ Advanced Yiew Show full path

| Mappingz | Conditions | Sart By

Step 6. View and Test the Query

Switch to Test View

1-24

Now you are ready to switch to the Test tab where you can look at the XQuery syntax
of the generated query you just constructed, and then run the query to test it.

Click the Test tab at the top of the workspace.

The Test tab is displayed as shown in the following figure.

Getting Started



Step 6. View and Test the Query

Figure 1-15 Test Tab
=10l

[untitled]* - Data View Builder
File Edit Wiew Query ‘Window Help

0]
Design W

rQuen |-Result

{-- Generated by Data View Builder 1.0 --}

[
<CustomerlrderReporc> D
{
for §MyWireless LD _D3.CUSTOMER 1 in document("HyWireless-LI
where (§MyWireless_LD_D35.CUSTOMER_1/CUSTOMER_ID eg "CUOITO
Eeturn
<customerlrders
<CUSTOMER:
<FIRST NAME>{ xf:data(¢MyWireless_LD_D&.CUSTOMER_1/F:
<LAST NAME»{ xf:data(§MyWireless LD D3. CUSTDI{ER_l/LI%‘E

&l [z
|Row 47 - Calumn 23

Query Parameter

| Mame H Walug H Type

[ Large Results

’—Quenr Result

Connected to t3:flocalhost7 001

Understanding the Generated XQuery

The Data View Builder generates the following XQuery for the query you constructed
with drag-and-drop tools.

Listing 1-1 Generated XQuery for Getting Started Query

{-- Generated by Data View Builder 1.0--}
<Cust oner Or der Report >

{

for $M/Wrel ess_LD DS. CUSTOMER 1 in docunent ("MWrel ess-LD DS")/db/ CUSTOVER
where ($M/Wrel ess_LD DS. CUSTOVER 1/ CUSTOMER ID eq "CUSTOMER 1")

return

<cust oner Or der >

<CUSTOVER>
<FI RST_NAME>{ xf:data($M/Wrel ess_LD DS. CUSTOMER 1/ FI RST_NAME) }</FI RST_NAME>
<LAST_NAME>{ xf:data($MyWreless_LD DS. CUSTOVER 1/ LAST_NAME) }</LAST_NAME>
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<CUSTOMER_| D>{ xf:data($MyWrel ess_LD DS. CUSTOMER 1/ CUSTOMER | D) }</ CUSTOMER | D>
<STATE>{ xf:data($MyWrel ess_LD DS. CUSTOMER 1/ STATE) }</ STATE>
<EMAI L_ADDRESS>{ xf:data($M/W rel ess_LD DS. CUSTOVER 1/ EMAI L_ADDRESS) }</ EMAI L_ADDRESS>
<TELEPHONE_NUMBER>{ cast as

xs: | ong(xf:data($MyWrel ess_LD DS. CUSTOMER 1/ TELEPHONE_NUMBER) ) } </ TELEPHONE_NUMBER>
</ CUSTOVER>
<wi r el ess_order s>

{
for $M/Wrel ess_LD_DS. CUSTOVER ORDER 2 in docunent ("MW rel ess-LD-DS")/ db/ CUSTOVER_ORDER
where ($MyWrel ess_LD DS. CUSTOVER 1/ CUSTOVER I D eq
$MyW rel ess_LD DS. CUSTOMER_ORDER 2/ CUSTOMER_| D)
return
<CUSTOVER_ORDER>
<ORDER_DATE>{ cast as xs:string(xf:data($M/Wreless_LD_DS. CUSTOMER ORDER_2/ ORDER_DATE) )
} </ ORDER_DATE>
<ORDER_| D>{ xf:data($M/Wrel ess_LD DS. CUSTOMER ORDER 2/ ORDER | D) }</ ORDER_| D>

<CUSTOMER_I D>{ xf:data($MyWrel ess_LD DS. CUSTOVMER ORDER 2/ CUSTOMER | D) }</ CUSTOMER | D>
<SH P_METHOD>{ xf:data($MyWrel ess_LD DS. CUSTOMER _ORDER 2/ SHI P_METHOD) }</ SHI P_METHOD>
<TOTAL_ORDER_AMOUNT>{ xf:data($M/Wrel ess_LD_DS. CUSTOVER_ORDER_2/ TOTAL_ORDER_AMOUNT)

} </ TOTAL_ORDER_AMOUNT>
</ CUSTOMER_ORDER>

</w rel ess_orders>
<br oadband_or der s>

{

for $MyBroadBand_LD DS. CUSTOVER _ORDER 3 in docunent (" MyBr oadBand- LD- DS") / db/ CUSTOVER_ORDER
where ($MyWrel ess_LD DS. CUSTOVER 1/ CUSTOVER I D eq

$MyBr oadBand_LD_DS. CUSTOVER_ORDER_3/ CUSTOMER | D)
return
<CUSTOVER_ORDER>
<ORDER_DATE>{ «xf: data($MBroadBand_LD DS. CUSTOMER ORDER 3/ ORDER DATE) } </ ORDER DATE>
<ORDER_| D>{ xf: dat a( $MyBr oadBand_LD_DS. CUSTOMER_ORDER_3/ ORDER_| D) }</ ORDER | D>
<CUSTOMER_| D>{ xf: data($MyBroadBand_LD_DS. CUSTOVER _ORDER 3/ CUSTOMER | D) } </ CUSTOVER | D>
<SHI P_METHOD>{ xf: dat a( $MyBr oadBand_LD_DS. CUSTOMER_ORDER_3/ SHI P_METHOD) } </ SHI P_METHOD>
<TOTAL_ORDER_AMOUNT>{ cast as

xs: deci mal (xf: dat a($My/BroadBand_LD_DS. CUSTOMER ORDER 3/ TOTAL_ORDER_AMOUNT) ) } </ TOTAL_ORDER_AMOUNT>
</ CUSTOVER_ORDER>

</ br oadband_or der s>
</ cust omer Or der >

}
</ Cust oner Or der Repor t >

Run the Query

When you are ready to run the query, click the Run query button on the toolbar in the
upper left.
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Run query button

[unl:iI:IEd]* - D=%a Yiew Builder

File Ed# Wiew Query Window Help

| Design || optimize | Test
||—E:!LIEI":.-'

The Liquid Data server process the query and the query result is displayed as shown in
the following figure and code listing.

Figure 1-16 Query Result on Test Tab

Data Yiew Builder i ] A
File Edit View Query Window Help
0]
Desian || Optimize | Test

FRuery |rResult
{—- Generated by Data View Builder 1.0 --} [=] |2 <CustonerlrderReports z
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<CustomerOrderReports> <CUSTOMER-
i ] <FIRST_NAME>JOHN_1</FIRST NAME>
for §MyWireless LD D5.CUSTOMER_ 1 in document("MyWirele <LAST NAMERKAY 1</LAST NAME-
where (§MyWireless_LD_D3.CUSTOMER_1/CUSTOMER_ID eqg " <CUSTOMER_ID-CUSTOMER 1< /CUSTOMEER I
return <STATE>Tw< /STATE>
<customerlrders> <EMATL_ADDRES3>abcfabe. com< /EMATL_AT)
<CUSTOMER- <TELEFHONE_NUMBEER-4081231234< /TELEFH
<FIRST_NAME>{ xf:data(sMyWireless_LD_D3.CUSTOMEER, < /CUSTOMER
& <LAST NAMES! xF:datarsHvIJireless LD DS.CUSTD}E&‘E <wireless_orders>
: <CUSTOMER_(OFDEFR>
|R0w 47 Column 23 : «<0RDER_DATE>Z2002-03-06-08: 00« /0RDE_
......................................................................................................... <ORDER ID:0RDER ID 1 0</0RDER ID-
Guery Parameter 2 - ity =
! <CUSTOMER_ID>CUSTOMER, 1< /CUSTOMER_
[ Marmne I Value I Type : <SHIP_METHOD>AIRS /SHIP_METHOD>

<TOTAL_ORDER_AMOUNT:>1000</TOTAL_OF

</CUSTOMER,_ORDER:

<CUSTOMER,_ORDER:
<ORDER_DATE>Z002-03-06-08: 00< /0RDE
<ORDER_ID>0RDER_ID_1_1</ORDER_ID>
<CUSTOMER_ID>CUSTOMER,_ 1< /CUSTOMER_
<SHIP_METHOD>AIR</SHIP_METHOD>
<TOTAL ORDER AMOUNT>Z000</TOTAL OHY]

[]

Query Result: 2
’]] Large Results [

Connected to t3:Mocalhost 7001
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Listing 1-2 XML for the Query Result

<Cust onmer Or der Report >
<cust onmer O der >
<CUSTOVER>
<FI RST_NAME>JOHN 1</ FI RST_NAME>
<LAST_NAME>KAY_1</ LAST_NAME>
<CUSTOVER_| D>CUSTOVER_1</ CUSTOVER_| D>
<STATE>TX</ STATE>
<EMAI L_ADDRESS>abc@bc. conx/ EMAI L_ADDRESS>
<TELEPHONE_NUMBER>4081231234</ TELEPHONE _NUVBER>
</ CUSTOVER>
<wi rel ess_orders>
<CUSTOVER_ORDER>
<ORDER_DATE>2002- 03- 06- 08: 00</ ORDER_DATE>
<ORDER_| D>ORDER _| D_1_0</ ORDER_| D>
<CUSTOMER | D>CUSTOVER 1</ CUSTOMER | D>
<SHI P_METHOD>AI R</ SHI P_METHOD>
<TOTAL_ORDER_AMOUNT>1000</ TOTAL_ORDER_AMOUNT>
</ CUSTOVER_ORDER>
<CUSTOVER_ORDER>
<ORDER_DATE>2002- 03- 06- 08: 00</ ORDER_DATE>
<ORDER_| D>ORDER | D_1_1</ ORDER | D>
<CUSTOVER | D>CUSTOVER 1</ CUSTOMER | D>
<SHI P_METHOD>AI R</ SHI P_METHOD>
<TOTAL_ORDER_AMOUNT>2000</ TOTAL_ORDER_AMOUNT>
</ CUSTOVER_ORDER>
</wirel ess_orders>
<br oadband_or der s>
<CUSTOVER_ORDER>
<ORDER_DATE>2002- 04- 09</ ORDER_DATE>
<ORDER_| D>ORDER _| D_1_0</ ORDER_| D>
<CUSTOMER | D>CUSTOVER 1</ CUSTOMER | D>
<SHI P_METHOD>AI R</ SHI P_METHOD>
<TOTAL_ORDER_AMOUNT>1000. 00</ TOTAL_ORDER_AMOUNT>
</ CUSTOVER_ORDER>
<CUSTOVER_ORDER>
<ORDER_DATE>2002- 04- 09</ ORDER_DATE>
<ORDER_| D>ORDER | D_1_1</ ORDER | D>
<CUSTOVER | D>CUSTOVER 1</ CUSTOMER | D>
<SHI P_METHOD>AI R</ SHI P_METHOD>
<TOTAL_ORDER_AMOUNT>1500. 00</ TOTAL_ORDER_AMOUNT>
</ CUSTOVER_ORDER>
</ broadband_or der s>
</ cust ormer Or der >
</ Cust orrer Or der Report >

Congratulations! You have successfully built and run a query using Liquid Data.
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Step 7. Save the Project

Note: If you want to switch back to the Design mode again, click the Design View
tab on the toolbar.

Step 7. Save the Project

We suggest you save the project file at this point if you have not done so already.
To save the project for the first time:
1. Choose the menu option File—>Save Project. The Save dialog is displayed.

2. Navigate to the directory in which you want to save your project and enter a
name for it in the File Name field.

3. Click Save.

The file is saved as a Data View Builder project with a . gqpr extension.

Note: Saving the project file is not the same as saving a query. For more information
on working with and saving projects, see Working with Projects in the
Building Queries and Data Views. For information on saving a query as a
stored query, see Saving a Query also in Building Queries and Data Views.

Next Steps

The process you just completed with these Getting Started steps is a thin slice of the
Liquid Data picture meant to help familiarize you with some of the basics. If you are
ready to learn more, try the following topics:

m  See the Liquid Data Product Overview for an end-to-end description of the
product and how to use it, including designing your business solution, using
security features, setting up clustering, creating the presentation layer,
understanding the recommended deployment scenarios, and using Liquid Data
with other BEA products like BEA WebLogic Portal, BEA Application
Integration, and BEA WebLogic Workshop.
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m  See Building Queries and Data Views for a detailed GUI overview and
description of Data View Builder features, the complete set of tasks you can
accomplish with the Builder, a full “Query Cookbook™, and lots more.

m  Sece the Liquid Data Administration Guide for information about how to
configure all the data source types supported Liquid Data supports including
Application Integration (Al), how to configure Security, how to set up
monitoring and reporting.
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